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1 Printer Overview
This printer lets you print, copy, and scan pictures and documents. In addition, this 
printer supports networking, letting you access the printer over a wireless (Wi-Fi) or 
Ethernet network.

Components

1 Control panel 12 Window for photo paper

2 Power cord port 13 Output tray extender with paper stop

3 USB port 14 Output tray

4 Ethernet port 15 Scanner glass

5 Rear-access cleanout area 16 Scanner lid

6 Duplexer (pulled out) 17 Front paper-edge guides

7 Printer access door 18 Main paper tray

8 CF card slot 19 Paper tray extender for legal paper

9 Front USB port 20 Left paper-edge guides

10 MS/XD/SD card slot 21 Photo paper tray

11 Printhead with ink cartridges installed

15

13

14

2

7

11

43

910 8

1

16

12

21

5

6

18

17

20

19
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Printer Overview
Control panel 

Feature Description

1 LCD Displays pictures, messages, and menus

2 Navigation buttons Used to navigate menus and scroll through pictures

3 OK button Selects a menu item, accepts a setting, and continues with the current 
operation

4 Back button Displays the next higher menu

5 Home button Displays the main menu; toggles between screens

6 Zoom buttons Enlarge or reduce the size of the displayed picture

7 Start button Begins copying, scanning, printing, maintenance task, and file transfer 

8 Cancel button Stops the current operation and returns to the menu; displays the next 
higher menu

9 Wi-Fi connectivity 
LED 

When lit, signals that the printer is connected to a wireless (Wi-Fi) 
network; blinks when searching for an available Wi-Fi network or 
reconnecting to an already configured network

10 On/Off button Turns the printer on or off

731 2 10984 5 6
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KODAK ESP 7200 Series All-in-One Printer
Home Center Software 
KODAK Home Center Software is installed as part of the software installation on 
your computer. The Home Center icon is added to your desktop and, depending on 
your configuration, to the Start menu. Use this icon to start Home Center Software.

On a computer with WINDOWS Operating System (OS), you can use Home Center 
Software to: 

• browse, crop, enhance, and edit pictures

• print and scan

• upgrade your printer with the latest software and firmware

• configure your printer

• order supplies

• access the KODAK Tips and Projects Center

• access this Extended User Guide

On a computer with MAC OS, you can use Home Center Software to scan, order 
supplies, configure your printer, or check for printer software updates.
www.kodak.com/go/aiosupport 3



Printer Overview
Configuring printer settings
NOTE: When you first power on the printer, the LCD prompts you to select the 

Language and Country/Region.

To set or change basic printer settings: 

1. Press Home.

2. Press  to select Printer Settings, then press OK.

3. Press  to select one of the following settings: 

• Date and Time

– Press OK, then press  to select Year, Month, Day, Hour, or Minute. 
Press or  to change the values; press OK when you are done.

NOTE: You can also synchronize the printer date and time to your computer using 
the Home Center software. 

• Button Sounds 

– Press  to select On or Off.

• Time to Low Power 

– Press  to change the time to energy-saving low power (select from 1 to 4 
hours in 0.5 hour increments). After the time to low power, the printer 
enters a low-power mode.

• DPOF (Digital Print Order Format) Printing 

– Press  to select On or Off.

• Language

– Press OK, press  to select a language, then press OK.

• Country/Region

– Press OK, press  to select a country or region, then press OK.

• Reset All Settings (see Resetting factory defaults, page 67)

NOTE: Resetting factory defaults does not change the date and time, language, 
country/region, or network settings

4. Press Back to return to the Main Menu. 
4 www.kodak.com/go/aiosupport



2 Networking Your Printer
This section explains how to configure or change your network settings.

Connecting to a wireless network
To connect your printer to an 802.11 wireless (Wi-Fi) network, refer to the following 
information. 

Before you connect

You need:

• A computer equipped with a network interface card or wireless networking 
support.

• A working 802.11 wireless network. Kodak recommends that you use a wireless 
access point/router that uses Dynamic Host Configuration Protocol (DHCP).

• To determine whether your wireless router supports Wi-Fi Protected Setup 
(WPS).

• Your network name (SSID - Service Set Identifier). You can obtain your SSID 
from the wireless access point, most commonly a router, using the router’s 
embedded Web server. See the manufacturer’s documentation provided with 
your wireless system for more information.

IMPORTANT: The SSID is case sensitive. 

• Your Wired Equivalent Privacy (WEP) key or Wi-Fi Protected Access 
(WPA/WPA2) passphrase.

• To temporarily disable your firewall until the printer is successfully installed and 
communicating. For information, go to www.kodak.com/go/inkjetnetworking.

Using the LCD keyboard

When you need to enter letters or numbers, a keyboard appears on the LCD. 

On the printer, press , , or  to select the letters and numbers, using the 
correct uppercase and lowercase letters. Press OK after each character. When you 
are done, select DONE, then press OK.

• To erase a character, select BKSP (backspace), then press OK.

• To change from uppercase to lowercase, select abc/123, then press OK.

• To change from lowercase to uppercase, select ABC/123, then press OK.

• To enter punctuation or symbols, select !@#, then press OK.
www.kodak.com/go/aiosupport  5
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Networking Your Printer
Connecting to a wireless network using the WiFi Setup Wizard
You can use the WiFi Setup Wizard on the printer to connect to your wireless 
network. Read the following procedures and use the one that is appropriate for your 
network setup.

Connecting to a non-WPS wireless router

To connect to your wireless network, you need to know the network name, which is 
also called the Service Set Identifier (SSID). You can obtain your network name from 
the wireless router. See the manufacturer's documentation for more information. 

If you have enabled security on your network, you also need to know the security 
string, which may be a Wired Equivalent Privacy (WEP) or a Wi-Fi Protected Access 
(WPA/WPA2) passphrase.

Record your network information, using the correct uppercase and lowercase letters 
for your WEP key or WPA/WPA2 passphrase.

1. Press Home.

2. Press  to select Network Settings, then press OK.

3. With WiFi Setup Wizard selected, press OK.

NOTE: The Wi-Fi radio turns on automatically when you select WiFi Setup Wizard.

The printer searches for available wireless networks within range, then displays 
the list in order of signal strength. For example: 

NOTE: If there are more networks than can be shown on the LCD, a  (page down) 
symbol appears in the bottom right of the display. If you don’t see your 
network in the list or want to change your network, select Rescan for 
Wireless Networks, then press OK.
6 www.kodak.com/go/aiosupport



KODAK ESP 7200 Series All-in-One Printer
4. If the name of your network is:

5. If your network requires a password, “Enter Security String” and a keyboard 
appear on the LCD. Use the LCD keyboard to enter the security string. (See 
“Using the LCD keyboard” on page 5.)

6. When the confirmation message appears, press OK.

If the printer is successfully connected, the Wi-Fi status light will be on.

If you are unable to connect your printer, go to 
www.kodak.com/go/inkjetnetworking for more information. 

7. If you haven’t yet installed the KODAK All-in-One Printer Software, go to 
www.kodak.com/go/aiodownloads and follow the on-screen instructions to 
install the software. 

The printer with a wireless connection is listed as the name of the printer plus a 
number (for example, KodakESP7200+0229).

Connecting to a WPS wireless router

If your router supports Wi-Fi Protected Setup (WPS), you can use WPS Connect. 
WPS lets you configure your printer for a wireless network by pressing buttons or 
entering a PIN.

To connect to a network using WPS:

1. Press Home.

2. Press  to select Network Settings, then press OK.

3. With WiFi Setup Wizard selected, press OK.

NOTE: The Wi-Fi radio turns on automatically when you select WiFi Setup Wizard.

4. With WPS Connect selected, press OK.

Listed Not listed

Press  to select your 
network, then press OK.

Make sure your wireless router is turned on and 
within range. If your wireless router does not 
broadcast its SSID (network name): 

a. Press  to select Unlisted Network, then 
press OK. 

b. Use the LCD keyboard to enter your network 
name. (See “Using the LCD keyboard” on page 5.)

c. Select WEP or WPA/WPA2 as required for 
your network's security setup, then press OK.
www.kodak.com/go/aiosupport 7
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Networking Your Printer
5. Select one of two methods of connecting: 

IMPORTANT: Before you press OK on the printer, make sure you know where the router's 
push button is, or where to enter the generated PIN. If necessary, consult 
your Internet service provider or router device manufacturer’s 
documentation for more information.

6. When the confirmation message appears, press OK.

If the printer is successfully connected, the Wi-Fi status light will be on.

If you are unable to connect your printer, go to 
www.kodak.com/go/inkjetnetworking for more information. 

7. If you haven’t yet installed the KODAK All-in-One Printer Software, go to 
www.kodak.com/go/aiodownloads and follow the on-screen instructions to 
install the software.

The printer with a wireless connection is listed as the name of the printer plus a 
number (for example, KodakESP7200+0229).

Setting up an IP address
IMPORTANT: You should only need to set up an IP address for your printer if you are 

having a problem with connecting. Typically, it is not necessary to set up an 
IP address. This procedure is for advanced users who know how to obtain 
the IP address for the printer.

All IP address entries have the following format: 000.000.000.000. Within each 
three-digit grouping, the number must be right-justified. If an address or subnet 
mask has only one or two characters between the periods, include one or two 
leading zeros in front of that number. For example: 

For information about obtaining the printer IP address, go to 
www.kodak.com/go/inkjetnetworking.

Pressing a button Entering a PIN

NOTE: You will have two minutes to 
press or select the WPS 
button. It may be a button on 
the device or a virtual button 
in the device’s software.

a. With Push Button Configuration 
selected, press OK. 

b. Press or select the WPS button for 
your wireless router.

a. Press  to select Generate 
WPS PIN, then press OK.

b. In your wireless router’s 
software, locate the PIN screen.

c. Enter the PIN you received on 
the LCD into the PIN screen, 
then follow the router’s 
instructions. 

The address as it may appear 
in your documentation

How to enter the address 
in the printer menu 

149.89.138.149 149.089.138.149

149.2.40.149 149.002.040.149
8 www.kodak.com/go/aiosupport
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KODAK ESP 7200 Series All-in-One Printer
To set up your IP address on the printer:

1. Press Home.

2. Press  to select Network Settings, then press OK.

3. Press  to select Advanced IP Address Setup, then press OK.

4. Press OK again to continue.

5. Select one of the following, then press OK:

• Dynamic (DHCP) 

• Automatic (Private)

• Manual (Static)

6. If you selected Manual (Static), you are prompted to enter an IP address, a 
Subnet Mask, a Gateway Address, and a DNS Server address. Press OK after 
each entry. Use the navigation buttons to enter each digit of the numbers.

Consult your Internet service provider or network administrator for more 
information.

Viewing the network configuration

To view the network configuration and verify that you are connected to your wireless 
network:

1. Press Home.

2. Press  to select Network Settings, then press OK.

3. Press  to select View Network Configuration, then press OK.

The wireless or Ethernet network settings appear on the LCD, including:

• Printer Hostname

• Connection

• Speed 

• IP Address

• IP Address Type

• Network Subnet

• Connected Network SSID

• Security

• Authentication

• Channel

• Region

• Radio (on/off)

• MAC Address

If the printer is connected to your network, you will see the network name and 
the word CONNECTED. 

4. To scroll through the information, press . 

5. When you are done, press OK.
www.kodak.com/go/aiosupport 9



Networking Your Printer
Printing the network configuration

To print the current network configuration:

1. Load plain paper into the printer. (See Loading paper in the main paper tray, 
page 17.)

2. Press Home.

3. Press  to select Network Settings, then press OK.

4. Press  to select Print Network Configuration, then press OK.

Installing your printer on additional computers on the network

To add your printer to another computer(s) on your network, install the KODAK 
All-in-One Printer Software on each computer. Go to 
www.kodak.com/go/aiodownloads and follow the on-screen instructions.

Connecting to another KODAK All-in-One Printer

If you are connecting to a newer model printer (for example, you have an ESP 7 
printer and now you are adding an ESP 7250 printer), you must install the software 
for the newer model.

If you are connecting to another ESP 7250 printer or to a previous model:

On a computer with WINDOWS OS:

1. Select Start > All Programs > Kodak > Kodak Printer Network Setup Utility.

• If your wireless all-in-one printer (example: KodakESP7200+0229) is not 
listed: 

a. Select No, my printer is not listed, then click Next.

b. From the drop-down list, select your printer.

c. Select Network - Wireless/WiFi, then click Next.
When your printer is detected, driver installation begins.

• If your wireless all-in-one printer (example: KodakESP7200+0229) is listed:

a. Highlight the all-in-one printer that is connected to your network.

b. Select Yes, my printer is listed, then click Next.
When your printer is detected, driver installation begins.

2. When driver installation is complete, click Done. 

On a computer with MAC OS:

1. Select Apple > System Preferences.

2. Under Hardware, select Print & Fax.

3. In the Print & Fax dialog box, click +.

4. Select your printer from the list, then click Add.
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KODAK ESP 7200 Series All-in-One Printer
Connecting to an Ethernet network
Before you connect, you need: 

• An Ethernet network that includes a router, switch, or hub with an Ethernet port.

• A Category 5 (or higher) Ethernet cable.

• To temporarily disable your firewall until the printer is successfully installed and 
communicating. For information, go to www.kodak.com/go/inkjetnetworking.

To connect to an Ethernet network:

1. Connect the Ethernet cable to the Ethernet port on the back of the printer. 

2. Connect the other end of the Ethernet cable to an available Ethernet port on 
your router, switch, or hub.

3. If you haven’t yet installed the KODAK All-in-One Printer Software, go to 
www.kodak.com/go/aiodownloads and follow the on-screen instructions to 
install the software and complete your setup.
www.kodak.com/go/aiosupport 11
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Networking Your Printer

12
Adding a network connection to a USB-connected computer
You can change the way you connect to your printer at any time.

Changing from USB to a wireless connection

To change the printer connection type from USB to a wireless (Wi-Fi) network:

If your printer is connected to a computer with WINDOWS OS:

1. Unplug the USB cable from your printer and computer.

2. On the printer control panel, press Home.

3. Press  to select Network Settings, then press OK.

4. Press  to select View Network Configuration, press OK, then confirm you have 
an IP address.

5. If you have not already done so, connect your printer to your wireless network. 
See Connecting to a wireless network, page 5.

6. On your computer, disable any firewall you have installed until you have 
successfully completed the installation. For more information on firewalls, go to 
www.kodak.com/go/inkjetnetworking.

7. Select Start > All Programs > Kodak > Kodak Printer Network Setup Utility.

• If your wireless all-in-one printer (example: Kodak ESP 7200+0229) is not 
listed:

a. Select No, my printer is not listed, then click Next.

b. Select your printer from the list.

c. Select Network - Wireless/WiFi, then click Next.
When your printer is detected, driver installation begins.

• If your wireless all-in-one printer (example: Kodak ESP 7200+0229) is listed: 

a. Highlight the all-in-one printer that is connected to your network.

b. Select Yes, my printer is listed, then click Next.
When your printer is detected, driver installation begins.

8. When driver installation is complete, click Done. 

The printer with a wireless connection is listed as the name of the printer plus a 
number (for example, KODAK ESP 7200+0229).
www.kodak.com/go/aiosupport
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KODAK ESP 7200 Series All-in-One Printer
If your printer is connected to a computer with MAC OS:

1. Unplug the USB cable from your printer and computer.

2. On the printer control panel, press Home.

3. Press  to select Network Settings, then press OK. 

4. Press  to select View Network Configuration, press OK, then confirm you have 
an IP address.

5. Select Apple > System Preferences.

6. Under Hardware, select Print & Fax.

7. In the Print & Fax dialog box, click +.

8. Select your printer from the list, then click Add.

The printer with a wireless connection is listed as the name of the printer plus a 
number (for example, Kodak ESP 7200+0229).

Changing from USB to an Ethernet connection

Before you connect, you need: 

• An Ethernet network that includes a router, switch, or hub with an Ethernet port.

• A Category 5 (or higher) Ethernet cable.

• To temporarily disable your firewall until the printer is successfully installed and 
communicating. For information, go to www.kodak.com/go/inkjetnetworking.

To change from a USB connection to an Ethernet network connection:

1. Unplug the USB cable from your printer and computer. 

2. Connect the Ethernet cable to the Ethernet port on the back of the printer. 

3. Connect the other end of the Ethernet cable to an available Ethernet port on 
your router, switch, or hub.
www.kodak.com/go/aiosupport 13
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Networking Your Printer
If your printer is connected to a computer with WINDOWS OS:

1. Select Start > All Programs > Kodak > Kodak Printer Network Setup Utility.

2. Select No, my printer is not listed, then click Next.

3. Select ESP 7200 Series from the printer drop-down list. 

4. Select Network - Ethernet cable, then click Next. 

The Printer Setup Utility searches for your printer and connects automatically.

5. Click Done.

If your printer is connected to a computer with MAC OS:

1. Select Apple > System Preferences.

2. Under Hardware, select Print & Fax.

3. In the Print & Fax dialog box, click +.

4. Select your printer from the list, then click Add.
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3 Handling Paper
For the best photo printing results, use KODAK Photo Papers, which are optimized to 
work with KODAK All-in-One Printers. 

For the best document printing results, use KODAK Document Papers or a paper 
with the COLORLOK Technology logo on the package. Use only paper that is 
designed for inkjet printers.

Paper types
You can use: 

• Plain paper — 20 to 24 lb / 75 to 90 gsm

• Photo paper — 6.5 to 12 mils (up to 290 gsm)

• Card stock — 110 lb / 200 gsm, max

• Envelopes — 20 to 24 lb / 75 to 90 gsm

• Transparencies — inkjet variety with white stripe

• Labels — all commercially available inkjet varieties on 8.5 x 11-in. or A4 sheets

Paper sizes
This printer has two paper trays, which accept different sizes of paper.

Main (bottom) paper tray 

Photo (top) paper tray
www.kodak.com/go/aiosupport  15



Handling Paper
The main paper tray accepts the following paper sizes: 

• 4 x 6 in. / 10 x 15 cm

• 4 x 7 in. / 10 x 18 cm

• 4 x 12 in. / 10 x 31 cm

• 5 x 7 in. / 13 x 18 cm

• 7.3 x 8.5 in / 18 x 22 cm 

• 8 x 10 in. / 20 x 25 cm

• 8.5 x 11 in. / 22 x 28 cm

• 8.5 x 14 in. / 22 x 36 cm

• A4 (8.3 x 11.7 in. / 21 x 30 cm) 

• A5 (5.8 x 8.3 in. / 15 x 21 cm)

• A6 (4.1 x 5.8 in. / 11 x 15 cm)

• B5 (6.9 x 9.8 in. / 18 x 25 cm)

The photo paper tray accepts the following paper sizes: 

• 4 x 6 in. / 10 x 15 cm

• 4 x 7 in. / 10 x 18 cm

• 5 x 7 in. / 13 x 18 cm

• A6 (4.1 x 5.8 in. / 11 x 15 cm)

NOTE: Do not load paper smaller than 4 x 6 in. / 10 x 15 cm in either paper tray.

Envelope sizes
The printer accepts the following envelope sizes (in the main paper tray): 

• C5 (6.7 x 9 in. / 16 x 23 cm)

• C6 (4.5 x 6.4 in. / 11 x 16 cm)

• DL (4.3 x 8.7 in. / 11 x 22 cm)

• US #7¾ (3.9 x 7.5 in. / 10 x 19 cm)

• US #9 (3.9 x 8.9 in. / 10 x 23 cm)

• US #10 (4.1 x 9.5 in. / 11 x 24 cm)

IMPORTANT: Do not load envelopes with cutout or clear windows. 
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KODAK ESP 7200 Series All-in-One Printer
Loading paper

Loading paper in the main paper tray

The main paper tray capacity is 100 sheets of plain paper.

To load plain paper:

1. Raise the output tray, and pull out the main paper tray. 

2. Make sure the left paper-edge guide is to the far left. 

3. Move the front paper-edge guide forward. 

4. Fan and stack the paper, then insert it into the tray.

5. Move the paper forward until it stops.

6. Move both the left and front paper-edge guides until they touch the paper.

Main paper tray 

Output tray 

Left paper-
edge guide 

Front paper-edge guide
www.kodak.com/go/aiosupport 17



Handling Paper
7. Push in the main paper tray until it clicks into place, and lower the output tray.

8. Pull out the output tray extender until it is fully extended.

9. Lift the paper stop.

NOTE: You may also load photo paper as small as 4 x 6 in. / 10 x 15 cm in the main 
paper tray. 

Output tray extender

Paper stop
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Loading legal-size paper in the main paper tray

The main (bottom) paper tray capacity is 100 sheets of legal-size (8.5 x 14 in. / 
22 x 36 cm) paper.

To load legal-size paper: 

1. Raise the output tray, and pull out the main paper tray. 

2. Make sure the left paper-edge guide is to the far left. 

3. Move the front paper-edge guide forward until it is fully extended. 

Main paper tray 

Output tray 

Left paper-
edge guide 

Front paper-edge guide
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Handling Paper
4. Press the paper tray extender, and pull the paper tray forward until it is fully 
extended. 

5. Fan and stack the paper, then insert it into the tray.

6. Move the paper forward until it stops.

7. Move both the left and front paper-edge guides until they touch the paper.

Paper tray 
extender
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8. Push in the main paper tray until it clicks into place, and lower the output tray.

9. Pull out the output tray extender until it is fully extended, but do not lift the 
paper stop.

Output tray extender

Paper stop
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Loading the photo paper tray
The photo (top) paper tray capacity is 40 sheets of photo paper.

To load photo paper: 

1. Raise the output tray, and pull out the photo paper tray. 

2. Move the left paper-edge guide to the far left. 

3. Move the front paper-edge guide forward. 

Photo paper tray 

Output tray 

Front paper-edge guide

Left paper-
edge guide 
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4. Fan and stack the photo paper, then insert it (short side first) into the tray with 
the logo side facing up and the glossy side down.

IMPORTANT: If the photo paper is loaded the wrong way, the ink on your pictures will be 
wet and the image quality will be affected. 

5. Move the paper forward until it stops.

6. Move both the left and front paper-edge guides until they touch the paper.

7. Push in the photo paper tray until it clicks into place, and lower the output tray. 
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Handling Paper
Loading envelopes
The main paper tray capacity is 20 envelopes.

IMPORTANT: Do not load envelopes with cutout or clear windows. 

To load envelopes: 

1. Raise the output tray, and pull out the main paper tray. 

2. Remove any paper from the tray.

3. Make sure the left paper-edge guide is to the far left. 

4. Move the front paper-edge guide forward. 

Main paper tray 

Output tray 

Left paper-
edge guide 

Front paper-edge guide
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5. Insert the envelopes into the tray with the flap up and against the right side of 
the tray.

6. Move the envelopes forward until they stop.

7. Move both the left and front paper-edge guides until they touch the envelopes. 

8. Push in the main paper tray until it clicks into place, and lower the output tray.
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4 Printing 
Print documents and lab-quality pictures on your printer. 

Changing paper trays
The printer has two paper trays. When you print documents, the printer 
automatically selects paper from the main (bottom) paper tray. When you print 
photos, the printer automatically selects paper from the photo (top) paper tray. You 
may, however, choose the top or bottom tray at any time. 

To change paper trays when printing from a computer with WINDOWS OS: 

1. Open the document you want to print, then select File > Print.

2. In the Print dialog box, make sure that KODAK ESP 7200 Series AiO is selected, 
then click Properties. 

3. In the General tab under Paper tray, click  then select Bottom Tray or Top Tray. 

4. Click OK to close the Properties dialog box.

5. Click OK to begin printing. 

To change paper trays when printing from a computer with MAC OS: 

1. Open the document you want to print, then select File > Print.

2. In the Print dialog box, make sure that Eastman Kodak Company ESP 7200 Series 
AiO is selected. 

3. From the Copies & Pages drop-down list, select Printer Options.

4. From the Paper Tray drop-down list, select Top tray or Bottom tray. 

5. Click Print.

To change paper trays when printing from the printer control panel: 

1. Press Home.

2. Press  to select Copy Photo or View and Print Photos. 

3. Press  to select Tray Selection, then press  to select Bottom Tray. 

NOTE: Top Tray is the default when printing pictures. You cannot change to the 
bottom tray from the control panel. 
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Printing documents
To print a document from your computer: 

1. Open the document. 

2. Select File > Print.

3. In the Print dialog box, select your KODAK Printer. 

4. Choose the pages to print, number of copies, etc, then click OK (on a computer 
with WINDOWS OS) or Print (on a computer with MAC OS). 

Printing two-sided documents

Print two-sided documents either automatically with the built-in duplexer or by 
manually rotating and reloading the paper. 

Automatic two-sided printing

The duplexer can print two-sided documents automatically on: 

• plain paper

• standard paper sizes 

– letter (8.5 x 11 in. / 22 x 28 cm)
– A4 (8.3 x 11.7 in. / 21 x 30 cm) 
– executive (7.3 x 10.5 in. / 18 x 27 cm)
– B5 (6.9 x 9.8 in. / 18 x 25 cm)

NOTE: The paper width must be 3.9 to 8.5 in. / 10 to 22 cm. The paper length must 
be 7 to 11.7 in. / 18 to 30 cm.

The duplexer cannot print: 

• borderless prints

• poster layout

Automatic two-sided printing from a computer with WINDOWS OS

To print two-sided documents from a computer with WINDOWS OS using the 
duplexer: 

1. Load plain paper into the paper tray.

2. Open the document you want to print, then select File > Print.

3. In the Print dialog box, make sure that KODAK ESP 7200 Series AiO is selected, 
then click Properties. 

4. Select the Layout tab. 

5. Select Automatically with Duplexer.

6. Under Flip on, select Long edge or Short edge, then click OK.

7. Click OK.
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Automatic two-sided printing from a computer with MAC OS

To print two-sided documents from a computer with MAC OS using the duplexer: 

1. Load plain paper into the paper tray.

2. Open the document you want to print, then select File > Print.

3. In the Print dialog box, make sure that Eastman Kodak Company ESP 7200 Series 
AiO is selected. 

4. In the Copies & Pages drop-down list, select Layout. 

5. In the Two-Sided drop-down list, select either Long-Edge binding or Short-Edge 
binding.

6. Click Print.

Manual two-sided printing

You can print two-sided documents on any size paper that the printer accepts (see 
“Paper sizes” on page 15) when you rotate the paper manually. 

IMPORTANT: Manual two-sided printing will not work on bar-coded photo paper (the bar 
code is on the back side). Manual two-sided printing can only be done on 
media that can absorb ink on both sides, such as plain paper or two-sided 
photo paper. 

Manual two-sided printing from a computer with WINDOWS OS

To print two-sided documents from a computer with WINDOWS OS: 

1. Load paper into the paper tray.

2. Open the document you want to print, then select File > Print.

3. In the Print dialog box, make sure that KODAK ESP 7200 Series AiO is selected, 
then click Properties. 

4. Select the Layout tab. 

5. Select Manual (Instructions provided), then click OK. 

6. Click OK.

7. When a message appears on your computer and printer LCD, remove the 
printed pages from the output tray. 

8. Rotate the printed pages 180 degrees, and place them into the paper tray 
(printed side up). 

9. Press Start on the printer. 
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Manual two-sided printing from a computer with MAC OS

To print two-sided documents from a computer with MAC OS: 

1. Load paper into the paper tray.

2. Open the document you want to print, then select File > Print.

3. In the Print dialog box, make sure that Eastman Kodak Company ESP 7200 Series 
AiO is selected. 

4. In the Copies & Pages drop-down list, select Paper Handling. 

5. In the Pages to Print drop-down list, select Odd Only.

6. In the Page Order drop-down list, select Reverse.

7. Click Print. 

8. When the odd pages have finished printing, remove the printed pages from the 
output tray.

9. Rotate the printed pages 180 degrees and place them into the paper tray 
(printed side up). 

10. Select File > Print.

11. In the Copies & Pages drop-down list, select Paper Handling. 

12. In the Pages to Print drop-down list, select Even Only.

13. In the Page Order drop-down list, select Normal.

14. Click Print. 

Printing forms

You can print the following preprogrammed forms:

• Graph paper

• Wide ruled

• Narrow ruled

• Grocery list

• Reminder list

• Tic-tac-toe

• Sheet music (portrait)

• Sheet music (landscape)

To print a preprogrammed form:

1. Press Home.

2. Press  to select Printable Forms, then press OK.

3. Press  to select a form. 

4. Press or  to select a quantity, then press OK. 

5. Press Start. 
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Printing pictures
You can print pictures with your all-in-one printer from: 

• A memory card inserted into a memory card slot

• A storage device (such as a flash drive) or camera connected to the front USB 
port with a USB cable

• A BLUETOOTH Technology enabled device (with the optional KODAK Wireless 
2.0 USB BLUETOOTH Adapter plugged into the front USB port)

• An iPhone, iPod touch or iPad Device (may not be available with all models). For 
information, go to www.kodak.com/go/picflick.

You can also print pictures using Home Center Software from your computer with 
WINDOWS OS. Home Center Software lets you edit and enhance your pictures 
quickly. Open Home Center Software, select Print Pictures, then follow the 
on-screen instructions.

On a computer with either MAC OS or WINDOWS OS, you can print pictures from 
KODAK EASYSHARE Software or any picture-editing or photo-management 
software. 

Printing from a memory card or USB-connected device

You can print pictures from the following cards or USB-connected devices:

IMPORTANT: If you use a memory card with an adapter, make sure you insert and remove 
the adapter and the memory card as a unit; do not remove the memory card 
while leaving the adapter in the printer.

Using default settings to print a picture

To print a picture from a memory card or USB-connected device using the default 

MS/XD/SD Card slot CF Card slot Front USB port

• MULTIMEDIA Card 
(MMC)

• XD Picture Card
• SECURE DIGITAL (SD) 

Card 
• SECURE DIGITAL High 

Capacity (SDHC) Card
• Variations of the 

memory cards above 
that require an adapter 
(for example, MEMORY 
STICK Duo, miniSD, 
microSD, and T-Flash)

• COMPACTFLASH 
Card (Types I and II)

• MICRODRIVE 

• PICTBRIDGE 
Technology enabled 
camera

• Flash drive
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settings: 

1. Insert the memory card into the appropriate slot, or connect the digital camera 
or portable drive to the front USB port. 

IMPORTANT: Use only one slot or port at a time. 

2. Press or  to select the picture you want to print. 

3. Press Start to begin printing.

The printer prints a single 4 x 6 in. / 10 x 15 cm picture. 

IMPORTANT: To prevent loss of data from your memory card, do not remove it from the 
printer while printing.

Changing the settings and printing a picture

You can change the print photos options for an individual picture or group of 
pictures, or you can change the settings and save them as the default. 

To print a picture or pictures using settings other than the default settings: 

1. Insert the memory card into the appropriate slot, or connect the digital camera 
or portable drive to the front USB port. 

IMPORTANT: Use only one slot or port at a time. 

Front USB port
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2. Press or  to select the picture you want to print, then press OK. 

3. Repeat step 2 for each picture you want to print.

4. Press Home.

5. Press  to select View and Print Photos, then press OK.

6. Press  to select an option, then press or  to change the setting. 

Front USB port

Print Photos Option Settings Description

View Photos -- Scroll through the pictures on the 
memory card.

Transfer All to PC -- To transfer all the pictures on the 
memory card to your computer, press 
OK then Start. (Your printer and 
computer must be connected with a USB 
cable.)

Rotate This Photo Press OK to rotate the selected photo. 

Quantity 1 (default) to 99 The number of copies that print.

Tray Selection Top Tray (default) Picture prints on the paper in the top 
tray.

Bottom Tray Picture prints on the paper in the bottom 
tray.
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7. When you have finished changing settings, press Start to begin printing.

IMPORTANT: To prevent loss of data from your memory card, camera, or portable drive, 
do not remove it from the printer while printing.

Print Size 2 x 3

3.5 x 5

4 x 6 (default)

4 x 7

5 x 7

If bottom tray is 
selected, the following 
choices also appear:

4 x 12

8 x 10

8.5 x 11 or A4

If the selected print size is smaller than 
the paper in the paper tray, the printer 
automatically arranges the pictures to 
best fit the paper size. 

Plain Paper Quality 
(only available if 
bottom tray is 
selected)

Normal (default) Good quality output; prints faster than 
Best.

Best The highest quality, but the slowest print 
speed; eliminates the banding effect that 
sometimes occurs when printing Draft or 
Normal.

Draft The fastest print speed, but the lowest 
quality.

Photo Paper Quality Automatic
(default)

The printer detects when you load photo 
paper and sets Best quality 
automatically.

Scene Balance On (default)
Off 

Adjusts the image brightness to correct 
for underexposure and reduces the 
variation in contrast in different areas of 
the picture.

Color Color (default) Prints full color.

Black & White Prints black and white (gray scale).

Add Date to Prints No (default)
Yes

Prints the date of the picture(s) (the date 
the picture was taken or last edited) in a 
corner of the print.

Save as Defaults No (default)
Yes

To save settings as the new default, 
press OK, select Yes, then press OK.

Print Photos Option Settings Description
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Printing tagged pictures

Some digital cameras let you tag (or “mark”) pictures on the memory card for 
printing. This creates a tag that is recognized by the printer. If you choose to print 
tagged pictures, they will be printed according to the default settings on your printer 
(unless otherwise specified by the tag from the camera).

NOTE: Refer to your camera user guide to determine whether your camera supports 
tagged (also “marked” or “DPOF”) functionality.

To print tagged pictures:

1. Insert the memory card into the appropriate slot. 

2. When the “Print tagged images?” message appears, press Start.
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Printing panoramic pictures 

To print a panoramic picture, load 4 x 12 in. / 10 x 31 cm paper, or US letter or A4 
paper in the main paper tray.

1. Insert the memory card into the appropriate slot, or connect the digital camera 
or portable drive to the front USB port. 

IMPORTANT: Use only one slot or port at a time. 

2. Press or  to select the picture you want to print, then press OK.

3. Press Home. 

4. Press  to select View and Print Photos, then press OK.

5. Press  to select Tray Selection, then press  to select Bottom Tray.

6. Press  to select Print Size, then press  to select 4 x 12.

7. Press Start to begin printing.

IMPORTANT: To prevent loss of data from your memory card, camera, or portable drive, 
do not remove it from the printer while printing.

Front USB port
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Zooming and cropping pictures

Use the zoom buttons to select a portion of your picture for printing. 

To zoom and crop a picture:

1. Insert the memory card into the appropriate slot, or connect the digital camera 
or portable drive to the front USB port. 

IMPORTANT: Use only one slot or port at a time. 

2. Press or  to select the picture you want to crop, then press OK. 

3. Press Zoom + to enlarge the picture on the LCD. A red box shows the area that 
will be printed.

NOTE: You can press Zoom + repeatedly to enlarge the picture in increments of 
0.25 up to a magnification of 5X. Press Zoom – to decrease the magnification 
in increments of 0.25 down to 1X. 

4. Use the navigation buttons to move the picture on the LCD up, down, left, or 
right. Only the part of the picture in the red box will print. The crop window 
matches the aspect ratio of the selected output print size. 

NOTE: Zooming and cropping does not change the saved picture on the memory 
card.  

5. When you are satisfied with the picture, press OK. The picture appears in the 
original view with a red box around the portion of the picture that will print.

6. Press Start to begin printing. 

Front USB port
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Printing pictures from a BLUETOOTH Technology enabled device

You can print pictures from wireless devices, such as mobile phones, digital 
cameras, and Personal Digital Assistants (PDAs) using the optional KODAK 
Wireless 2.0 USB BLUETOOTH Adapter. 

To print a picture from a BLUETOOTH Technology enabled device: 

1. Insert the KODAK Wireless 2.0 USB BLUETOOTH Adapter into the front USB 
port. 

2. “Pair” the printer and the device so they can communicate. 

NOTE: You must “pair” from your device’s interface. For instructions, see the user 
manual for your device. 

3. Select the picture you want to print, then select Send to begin printing. 

The printer prints one 4 x 6 in. / 10 x 15 cm picture. 

NOTE: See the user guide for your device for more information.

Printing pictures or documents from a wireless device
Wirelessly print pictures from an iPhone, iPod touch, or iPad* at the touch of a 
button. Download the KODAK Pic Flick App from the App Store, or go to 
www.kodak.com/go/picflick for more information. 

* Compatible with iPhone (with MAC OS 2.2 or later), iPod touch (2nd generation), 
and iPad.
www.kodak.com/go/aiosupport 37

http://www.kodak.com/go/pickflick
http://www.kodak.com/go/pickflick
http://www.kodak.com/go/picflick


Printing
Transferring pictures to a computer
You can transfer .jpg, .mov, and .wav files from a memory card in the printer to your 
computer. To transfer these files, the printer must be connected to your computer 
with a USB cable and Home Center Software must be installed on your computer.

NOTE: If you have large video files or a large number of pictures (400 or more), we 
recommend that you use a memory card reader attached directly to your 
computer to transfer them. 

Transferring pictures to a computer with WINDOWS OS
1. Insert the memory card into the memory card slot on the printer. 

2. Press Back.

3. Press  to select View and Print Photos, then press OK.

4. Press  to select Transfer All to PC, then press OK. 

5. Press Start.

6. If your computer is connected to a wireless network and with a USB cable, select 
the USB-connected printer (no number after the printer name). 

7. Follow the on-screen instructions on your computer.

Transferring pictures to a computer with MAC OS
1. Insert the memory card into the memory card slot on the printer. 

2. Press Back.

3. Press  to select View and Print Photos, then press OK.

4. Press  to select Transfer All to PC, then press OK. 

5. Press Start.

6. If your computer is connected to a wireless network and with a USB cable, select 
the USB-connected printer (no number after the printer name). 

7. Use iPhoto or Image Capture on your computer to complete the transfer.
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5 Copying
You can copy documents and photographs with your all-in-one printer. The printer 
produces high-quality color or black-and-white copies on a variety of paper types 
(see Paper types, page 15). 

Copying a document
You can copy a document using the default settings, or you can make adjustments to 
the quantity, size, quality, and brightness of your copies. When you copy a 
document, the printer will always use paper from the main (bottom) paper tray.

Using the default settings to copy a document 

The default settings are either the factory default settings (see Resetting factory 
defaults, page 67), or defaults that you have set on the printer (see Save as Defaults, 
page 41). 

To copy a document using the current default settings:

1. Lift the scanner lid, and place the document face down in the right-front corner 
of the scanner glass.

2. Close the lid. 

3. Press Home. 

4. Press Start to begin copying. 
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Adjusting the settings and copying a document

To copy a document using settings other than the default settings:

1. Lift the scanner lid, and place the document face down in the right-front corner 
of the scanner glass.

2. Close the lid. 

3. Press Home. 

4. Make sure Copy Document is selected, then press OK.

5. Press  to select an option, then press or  to change the setting.

Copy Document 
Option

Setting Description

Quantity 1 (default) to 99 The number of copies that print.

Color Color (default) Prints full color.

Black & White Prints black and white (gray scale).

Copy Size Same Size 
(default)

The copy is the same size as the 
original.

Fit to Page The printer detects the size of the 
original on the scanner glass and the 
size of the paper in the paper tray, and 
automatically reduces or enlarges the 
original so that the copy fits on the 
paper.

20% to 500% Reduces up to 20% or enlarges up to 
500% of the original size.
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6. Press Start to begin copying. 

Changing the number of copies of a document
To change the number of copies:

1. Lift the scanner lid, and place the document face down in the right-front corner 
of the scanner glass.

2. Close the lid. 

Plain Paper Quality Normal
(default)

Good quality output; prints faster than 
Best.

Best The highest quality, but the slowest 
print speed; eliminates the banding 
effect that sometimes occurs when 
printing Draft or Normal.

Draft The fastest print speed, but the lowest 
quality.

Photo Paper Quality Automatic
(default)

The printer detects photo paper in the 
paper tray and sets Best quality 
automatically.

Brightness Normal, -3 to +3 
(Normal is default) 

Lightens or darkens the copy. 
Normal is no change from the original; 
-3 is the darkest; +3 is the lightest.

Save as Defaults No / Yes To save settings as the new default, 
press OK, select Yes, then press OK.

Copy Document 
Option

Setting Description
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3. Press Home. 

4. Make sure Copy Document is selected, then press  or  to select a number.

5. Press Start to begin copying. 

Enlarging or reducing a document

To enlarge or reduce the size of the copy:

1. Lift the scanner lid, and place the document face down in the right-front corner 
of the scanner glass.

2. Close the lid. 

3. Press Home. 

4. Make sure Copy Document is selected, then press OK. 

5. Press  to select Copy Size.

6. Press  or  to select an enlargement or reduction.

7. Press Start to begin copying. 
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Darkening or lightening a copy

To darken or lighten the copy:

1. Lift the scanner lid, and place the document face down in the right-front corner 
of the scanner glass.

2. Close the lid. 

3. Press Home. 

4. With Copy Document selected, press OK. 

5. Press  to select Brightness.

6. Press  to select a number below zero for a darker copy, or press  to select a 
number above zero for a lighter copy.

7. Press Start to begin copying. 
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Copying a photograph
You can copy a photograph using the default settings, or you can make adjustments 
to the quantity, size, quality, and brightness of your copies. When you copy a 
photograph, the printer will use paper from the top paper tray, unless you specify 
otherwise.

Using the default settings to copy a photograph 

The default settings are either the factory default settings (see Resetting factory 
defaults, page 67), or defaults that you have set on the printer (see Save as Defaults, 
page 46). 

To copy a photograph using the current default settings:

1. Lift the scanner lid, and place the photograph face down in the right-front corner 
of the scanner glass.

2. Close the lid. 

3. Press Home. 

4. Press  to select Copy Photo.

5. Press Start to begin copying. 
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Adjusting the settings and copying a photograph

To copy a photograph using settings other than the default settings: 

1. Lift the scanner lid, and place the photograph face down in the right-front corner 
of the scanner glass.

2. Close the lid. 

3. Press Home. 

4. Press  to select Copy Photo, then press OK. 

5. Press  to select an option, then press or  to change the setting. 

Copy Photo Option Setting Description

Quantity 1 (default) to 99 The number of copies that print.

Color Color (default) Prints full color.

Black & White Prints black and white (gray scale).

Tray Selection Top Tray (default) Copy is made on the paper in the top 
tray.

Bottom Tray Copy is made on the paper in the 
bottom tray.
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6. Press Start to begin copying.

Copy Size 2 x 3

3.5 x 5

4 x 6 (default)

4 x 7

5 x 7

If bottom tray is 
selected (above), 
the following choices 
also appear:

4 x 12

8 x 10

8.5 x 11 or A4

The printer enlarges or reduces the 
original to make it the copy size you 
select. 

If the selected copy size is smaller 
than the paper in the paper tray, the 
printer automatically arranges the 
pictures to best fit the paper size. 

Plain Paper Quality

(available only if 
bottom tray is 
selected)

 Normal 
(default)

Good quality output; prints faster than 
Best.

Best The highest quality, but the slowest 
print speed; eliminates the banding 
effect that sometimes occurs when 
printing Draft or Normal.

Draft The fastest print speed, but the lowest 
quality.

Photo Paper Quality Automatic
(default)

The printer detects photo paper in the 
paper tray and sets Best quality 
automatically.

Brightness Normal, -3 to +3 
(Normal is default) 

Lightens or darkens the copy. 
Normal is no change from the original; 
-3 is the darkest; +3 is the lightest.

Preview No (default) / Yes To see a preview of the photograph on 
the LCD, select Yes. 

Save as Defaults No / Yes To save settings as the new default, 
press OK, select Yes, then press OK.

Copy Photo Option Setting Description
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Changing the number of copies of a photograph

To change the number of copies:

1. Lift the scanner lid, and place the photograph face down in the right-front corner 
of the scanner glass.

2. Close the lid. 

3. Press Home.

4. Press  to select Copy Photo, then press OK.

5. Make sure Quantity is selected. 

6. Press  or  to select a number. 

7. Press Start to begin copying. 
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Enlarging or reducing a photograph
To enlarge or reduce the size of the copy:

1. Lift the scanner lid, and place the photograph face down in the right-front corner 
of the scanner glass.

2. Close the lid. 

3. Press Home.

4. Press  to select Copy Photo, then press OK.

5. Press  to select Copy Size.

6. Press  or  to select the copy size.

NOTE: If you select a copy size larger than 5 x 7 in. / 13 x 18 cm, press  to select 
Tray Selection, then press  to select Bottom Tray. Make sure that the paper 
in the bottom tray is the size and type (plain paper, photo paper, etc.) that 
you want.

7. Press Start to begin copying. 
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Darkening or lightening a copy of a photograph

To darken or lighten the copy:

1. Lift the scanner lid, and place the photograph face down in the right-front corner 
of the scanner glass.

2. Close the lid. 

3. Press Home.

4. Press  to select Copy Photo, then press OK.

5. Press  to select Brightness.

6. Press  to select a number below zero for a darker copy, or press  to select a 
number above zero for a lighter copy.

7. Press Start to begin copying. 
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6 Scanning
Scanning digitizes documents and pictures, and sends the digital files to your 
computer.

When you scan, the digital file can: 

• Open in Home Center Software

• Open in a third-party scanner software

• Be saved in a format and location that you determine (see Changing the scan 
settings for scanning from the control panel, page 50)

Scanning from a software program on the computer (such as Home Center 
Software) gives you more options, but you can also scan from the printer control 
panel. 

Before you begin scanning
Make sure that the printer is connected to a computer using a USB cable, Ethernet 
cable, or wireless network (see Networking Your Printer, page 5).

Changing the scan settings for scanning from the control panel

Make sure that Home Center Software is installed on the computer, then change the 
scan settings in the Home Center Software. These settings are the defaults that the 
printer uses when you scan from the printer control panel.

1. Open Home Center Software

2. Select Tools and Documentation. 

3. Select Printer Scan Settings. 

4. Adjust settings for scanning documents and pictures as described below.

To adjust settings for scanning documents, select the Document tab, then select:

• Color, Black and white, or Grayscale

• File format (.pdf, .rtf, .tif, .jpg) 

• Resolution (75, 150, 300, 600 dpi) 

• Prompt for File Name and Location or Automatically Save 

If you choose to automatically save, you must specify:

– Base name (by default, scanned files are named “scan1”, “scan2”, etc)
– Location (folder) where the scanned files will be saved
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To adjust settings for scanning pictures, select the Picture tab, then select:

• Color or Black and white

• File format (.jpg, .bmp, .tif) 

• Resolution (75, 150, 300, 600 dpi) 

• Quality (Best for E-mail, Normal, High, Maximum)

• Prompt for File Name and Location or Automatically Save 

If you choose to automatically save, then specify:

– Base name (by default, scanned files are named “scan1,” “scan2,” etc)
– Location (folder) where the scanned files will be saved

Before saving a scanned file, you can preview it in Home Center Software, crop and 
sharpen the image, and adjust color, if desired. See the Home Center Software Help 
(? icon) for instructions.

Scanning from the computer
To scan a document or a picture: 

1. Lift the scanner lid, and place the original face down in the right-front corner of 
the scanner glass.

2. Close the lid. 

3. Open Home Center Software, then:

• On a computer with WINDOWS OS, select Scan Documents and Pictures, 
then follow the on-screen instructions.

• On a computer with MAC OS, select the Tools tab, click Scan Application, 
then follow the on-screen instructions. 
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Scanning multiple pictures simultaneously

Using Home Center Software, you can scan multiple pictures simultaneously and 
save them as separate files. 

When scanning multiple pictures, leave space between the pictures so that the 
printer can detect the separate pictures. Any pictures that overlap are interpreted as 
a single picture. 

Scanning multiple pictures when connected to a computer with WINDOWS OS

To scan multiple pictures simultaneously, and save them as separate files: 

1. Lift the scanner lid, and place the pictures face down on the glass, leaving space 
between the pictures. 

2. Close the lid. 

3. Open Home Center Software, then select Tools and Documentation. 

4. Select Printer Scan Settings, then select the Picture tab. 

5. Select Automatically Detect Pictures, if it is not selected, then click OK.

6. Click the Home icon in the top right corner, then select Scan Documents and 
Pictures. 

7. Make sure that Picture is selected and Collage - Combine all pictures is cleared, 
then follow the on-screen instructions.

NOTE: Click the Help icon for additional instructions. 

Scanning multiple pictures when connected to a computer with MAC OS

To scan multiple pictures simultaneously, and save them as separate files: 

1. Lift the scanner lid, and place the pictures face down on the glass, leaving space 
between the pictures. 

2. Close the lid. 

3. Open Home Center Software, and select your printer.

4. Select the Tools tab.

5. Click Scan Application.

6. Select Color Picture or Black and White Picture. 

7. Select Automatically detect multiple pictures, if it is not selected.

8. Click Preview or Scan All, and follow the on-screen instructions.

NOTE: Click the Help icon for additional instructions. 
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Scanning from the control panel
To scan a document or a picture from the control panel: 

1. Lift the scanner lid, and place the original face down in the right-front corner of 
the scanner glass.

2. Close the lid. 

3. Press Home. 

4. Press  to select Scan, then press OK.

5. Press  to select an option, then press or  to change the setting.

Scan Option Settings Description

Scan To USB-connected 
computer
(default)

The scanned file is sent to the 
USB-connected computer.

Name of computer 
(only if a computer is 
connected by 
wireless or Ethernet 
network)

The scanned file is sent to the 
computer on the wireless or Ethernet 
network.

Memory card The scanned file is sent to the 
memory card in one of the card slots. 

IMPORTANT: Use only one card slot at 
a time. 
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Scanning
6. Press Start to begin scanning. 

The scanned file appears at the destination you specified. 

Scan What Document
(default)

Sets the scan settings for scanning a 
document (see Changing the scan 
settings for scanning from the control 
panel, page 50).

Photo Sets the scan settings for scanning a 
photograph (see Changing the scan 
settings for scanning from the control 
panel, page 50).

Destination File
(default)

Sends the scanned file in the format 
and to the location on your computer 
that you designate (see Changing the 
scan settings for scanning from the 
control panel, page 50).

Application Sends the scanned file to Home 
Center Software.

Save as Defaults No / Yes To save the settings as the new 
default, press OK, select Yes, then 
press OK.

Scan Option Settings Description
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7 Maintaining Your Printer
Your printer requires little maintenance. However, Kodak recommends cleaning the 
scanner glass and lid regularly to remove dust and fingerprints, which affect the 
quality and accuracy of scanning.

Except while cleaning the printer, keep the printer plugged into an AC power outlet. 
If you use a power strip, don't turn off the power strip. (The printer does not 
necessarily have to be turned on, but should be plugged in.)

Keep the printhead and ink cartridges in the printer at all times to help prevent 
damage to the printhead.

For recycling and/or disposal information, contact your local authorities. In the US, 
go to the Electronics Industry Alliance at www.eia.org or go to 
www.kodak.com/go/recycle. 

General care and cleaning
CAUTION:

Always disconnect the power to the printer before cleaning it. Do not use 
harsh or abrasive cleaners on any part of the printer.

• To clean the printer, wipe the outside with a clean, dry cloth.

• Keep the surrounding area vacuumed and litter-free. 

• Protect the printer from tobacco smoke, dust, and liquid spills. 

• Do not place objects on the printer. 

• Keep the printer supplies away from direct sunlight and out of high-temperature 
environments.

• Do not allow chemicals to come into contact with the printer. 
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Maintaining Your Printer
Cleaning the scanner glass and document backing
The scanner glass can get smudged and minor debris can accumulate on the white 
document backing under the scanner lid. Periodically clean the scanner glass and 
document backing. 

CAUTION:
Do not use harsh or abrasive cleaners on any part of the printer. 
Do not spray liquid directly on the glass.
Do not use paper-based wipes on the document backing as they can 
scratch it.

To clean the scanner glass and document backing under the scanner lid: 

1. Unplug the printer and lift the scanner lid. 

2. Wipe the glass with a soft cloth or sponge, slightly moistened with a 
nonabrasive glass cleaner. 
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3. Dry the glass with a lint-free cloth.

4. Gently clean the document backing with a soft cloth or sponge, slightly 
moistened with mild soap and warm water. 

5. Dry the document backing with a chamois or soft, lint-free cloth.

NOTE: If the document backing needs further cleaning, use isopropyl (rubbing) 
alcohol on a soft cloth, then wipe thoroughly with a cloth moistened with 
water to remove any residual alcohol. 

6. When you finish cleaning, plug in the printer.
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Replacing ink cartridges
Your printer uses both black and color ink cartridges. You can check the approximate 
ink levels on the LCD (see Checking ink levels, page 66) or in Home Center Software. 
When an ink cartridge is out of ink, the printer LCD displays a message stating that 
the black or color ink cartridge needs replacing.

IMPORTANT: Do not use non-Kodak brand or refilled ink cartridges.

To replace an ink cartridge: 

1. Make sure your printer is on.

2. Lift the printer access door, and wait for the carriage to move to the access 
position.

The ink cartridges are located in the printhead. 

Color ink cartridge

Printhead Black 
ink cartridge
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3. Pinch the tab on the ink cartridge and lift it out of the printhead. 

4. Remove the new ink cartridge from its bag.

IMPORTANT: To prevent the printhead from drying out, insert the ink cartridge into the 
printhead immediately.

5. Remove the protective cap from the cartridge.
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Maintaining Your Printer
6. Insert the ink cartridge into the printhead.

7. Press down on the ink cartridge tab until you hear a click.

8. Close the printer access door. 
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Replacing the printhead
IMPORTANT: Replacing the printhead is not a regular maintenance procedure. Replace 

the printhead only if you receive a new printhead from Kodak.

To replace the printhead:

1. Make sure your printer is on.

2. Lift the printer access door, and wait for the carriage to move to the access 
position.

3. Remove both ink cartridges and set them aside. 
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Maintaining Your Printer
4. Unlatch the used printhead by lifting the button in the center of the carriage.

5. Lift the used printhead out of the carriage.

6. Remove the new printhead from its bag.

CAUTION:
Do not touch the gold contacts on the printhead, as doing so may damage it.
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7. Remove the two plastic, protective caps.

8. Place the new printhead into the carriage. 

9. Push firmly against the target label of the printhead until you hear a loud snap.
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10. Insert the black ink cartridge into the printhead. 

11. Press down on the ink cartridge tab until you hear a click.

12. Repeat steps 10 - 11 for the color ink cartridge. 
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13. Close the printer access door. 

The printer detects the new printhead. Follow the instructions on the LCD to 
calibrate your printer. 

Updating the software and printer firmware
Using the latest software and firmware helps ensure optimal performance of your 
printer.

NOTE: Firmware is the software that runs on the printer.

When you open Home Center Software on a computer with WINDOWS OS, the 
software automatically checks for software and firmware updates. On a computer 
with MAC OS, you have to check manually for updates. 

Use the following procedure to update manually.

Updating if your printer is connected to a computer with WINDOWS OS

To update the software:

1. Make sure that your computer is connected to the Internet. 

2. Open Home Center Software.

3. Click Tools and Documentation.

4. Under Web Links, click Check for Software Updates to check whether software 
updates are available.

5. If there are updates, click Next and follow the on-screen instructions. 

To update the printer firmware:

1. Make sure that your computer is connected to the Internet. 

2. Connect the printer to the computer with a USB cable, Ethernet cable, or 
wirelessly (if not currently connected). 

3. Open Home Center Software.

4. Click Tools and Documentation.

5. Under Web Links, click Check for Printer (Firmware) Updates.

6. If there are updates, click Next and follow the on-screen instructions.

IMPORTANT: Do not turn off or unplug your printer or your computer during the update. 
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Updating if your printer is connected to a computer with MAC OS

To update the software:

1. Make sure that your computer is connected to the Internet. 

2. Open Home Center Software.

3. On the File menu, select Check for Updates.

4. If there are updates, follow the on-screen instructions.

To update the firmware:

1. Go to www.kodak.com/go/esp7250downloads.

2. Connect the printer to the computer with a USB cable, Ethernet cable, or 
wirelessly (if not currently connected). 

3. Select your operating system from the drop-down list.

4. Click Select in the Firmware box.

5. Read the instructions, click Download, then follow the on-screen instructions.

IMPORTANT: Do not turn off or unplug your printer or your computer during the update. 

Monitoring and adjusting printer performance
From the control panel, you can perform tasks to help keep the printer functioning 
well.

Checking ink levels

To check the ink levels: 

1. Press Home.

2. Press  to select Maintenance, then press OK.

3. With Check Ink Levels selected, press OK.

The LCD shows approximate levels of ink in the cartridges so you know when it’s 
time to order replacement cartridges. 
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Resetting factory defaults
To reset defaults to the factory default settings: 

1. Press Home.

2. Press  to select Printer Settings.

3. Press  to select Reset All Settings, then press OK. 

4. When you see the message, “This will reset printer settings to factory defaults,” 
press OK.

NOTE: Resetting factory defaults does not change the date and time, language, 
country/region, or network settings.
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8 Troubleshooting

Basic troubleshooting
Some problems can be resolved quickly by power cycling the printer: Turn off your 
printer. Wait five seconds. Turn on the printer. 

Use the following information to help troubleshoot problems with your printer.

Problem Possible Solutions

Printer does not 
power on

• Make sure you are using the power cord that came with 
your printer. 

• Make sure the power cord is connected to the AC adapter 
and is plugged into an outlet or power strip.

• If the USB 2.0 cable was disconnected from the printer, 
then reconnected, or if power to the printer was 
interrupted, restart the computer.

Printer not detected • Make sure your printer is plugged in and turned on.
• If you are using a USB cable, make sure: 

– you have a USB 2.0 cable.
– that the USB cable is connected to both your printer and 

your computer.
• If you are using a wireless connection, make sure:

– the printer is connected to your wireless network (check 
the Wi-Fi connectivity LED and the SSID).

– your router is transmitting data.
– the firewall (excluding WINDOWS Firewall) is allowing 

the services needed for your printer.
For additional information, go to 
www.kodak.com/go/inkjetnetworking.

Wireless 
connectivity 

For wireless connectivity issues, go to 
www.kodak.com/go/inkjetnetworking.

Printhead carriage 
jam

• Open the printer access door and clear any obstructions.
• Check that the printhead and ink cartridges are installed 

correctly.
(The printhead and ink cartridges are installed correctly 
when you hear them click into place.)
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Print quality • For best results, use KODAK Paper or a paper with the 
COLORLOK Technology logo on the package.

• Make sure the paper is loaded correctly (see Loading paper, 
page 17).

For more information, go to www.kodak.com/go/itg, select 
All-in-one printer, then Print Quality (missing colors, blank 
prints, etc).

Ink cartridge • Check that KODAK Ink Cartridge(s) are installed. Do not 
use non-Kodak brand or refilled ink cartridges. 

• Remove, then install the cartridges again. Make sure the 
cartridges click into place.

Paper jam • Check for paper behind the duplexer in the rear-access 
cleanout area.

• Remove the duplexer and gently remove any paper from 
inside the printer. 

• Make sure the paper in the tray is free of tears or creases.
• Make sure you do not overload the paper tray.
For more information, go to www.kodak.com/go/itg. Select 
All-in-one printer, then Paper jam.

Error messages or 
other problems you 
cannot resolve

If you need to contact Kodak (see www.kodak.com/go/contact), 
have the following information available:

• Kodak Service Number (located inside the printer when you 
open the printer access door)

• Printer model number (located on the control panel)
• Computer model, operating system, and version of Home 

Center Software
• Exact wording of any error message(s)

Problem Possible Solutions
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Troubleshooting
Getting help on the Web
For more troubleshooting information:

Get help with wireless networking. www.kodak.com/go/inkjetnetworking

Use our Step-by-Step Solutions and 
Repair tool to troubleshoot common 
problems.

www.kodak.com/go/itg

Search our knowledge base of FAQs 
(Frequently Asked Questions).

www.kodak.com/go/esp7250support

Download the latest firmware and 
software for optimal printer 
performance.

www.kodak.com/go/esp7250downloads

See the recommended system 
requirements.

www.kodak.com/go/esp7250specs

Get help with problems you cannot 
resolve.

Contact Kodak at www.kodak.com/go/contact 
and have the following information available: 

– Kodak Service Number (located inside the 
printer when you open the printer access 
door)

– Printer model number (located on the 
control panel)

– Computer model, operating system, and 
version of Home Center Software
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Status lights
The status lights indicate the condition of the printer. There are two status lights on 
the printer, one that indicates power, the other indicates Wi-Fi status.

Power status light

Wi-Fi status light 

Power light What it means

Off The printer is turned off.

• Press the on/off button to turn on power.

The printer does not have power.

• Make sure that the power cord is plugged into the back of the 
printer and into an electrical outlet, and that the electrical 
outlet has power.

Blinking The printer is busy.

• Wait for the printer to finish the task.

On The printer is ready.

Wi-Fi status light What it means

Off The Wi-Fi radio is either turned off or is turned on but not 
connected to a wireless network.

Blinks continuously The Wi-Fi radio is turned on and the printer is searching for 
available wireless networks within range.

Blinks intermittently The Wi-Fi radio is turned on and the printer cannot find any 
available wireless networks within range, or the Wi-Fi radio 
connection has been interrupted or is too weak to send signals.

To find and connect to an available wireless network within 
range, press OK, turn the Wi-Fi radio off, and run the WiFi Setup 
Wizard (see Connecting to a wireless network, page 5).

On The Wi-Fi radio is turned on and there is a working connection 
between the printer and a wireless network.
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9 Product and Safety Specifications
The following specifications are subject to change without notice.

Features and Specifications

Print performance

Photo printing features

Black print speed Up to 32 pages per minute on plain paper

Color print speed Up to 30 pages per minute on plain paper

Print technology Continuous-tone, thermal inkjet

Print quality modes Draft, Normal, and Best on plain paper

Photo quality mode on photo paper

Quantity 1 to 99 
(may vary for different models of the 7200 series printers)

Print sizes 2 x 3 in. (5 x 8 cm)

3.5 x 5 in. (9 x 13 cm)

4 x 6 in. (10 x 15 cm)

4 x 7 in. (10 x 18 cm)

4 x 12 in. (10 x 30 cm) (Panoramic)

5 x 7 in. (13 x 18 cm)

8 x 10 in. (20 x 25 cm)

US Letter - 8.5 x 11 in. (22 x 28 cm)

A4 (21 x 30 cm)

Quality Best, Normal, Draft, Automatic

Auto-detect media Auto-detect plain paper, photo paper, and transparency

Optimize image quality for KODAK Photo Papers with barcode

Image enhancement KODAK PERFECT TOUCH Technology with 
Home Center Software (from the computer only)

Color Black-and-white or color

Scene balance On (default), Off 
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Copy document features

Copy photo features

Scanning features

Color Black-and-white or color

Quantity 1 to 99 copies 
(may vary for different models of the 7200 series printers)

Copy sizes Same Size, Fit-to-Page, 20% to 500% 
(may vary for different models of the 7200 series printers)

Plain paper quality Best, Normal, Draft

Brightness – 3 to + 3

Color Black-and-white or color

Quantity 1 to 99 copies 
(may vary for different models of the 7200 series printers)

Copy sizes 2 x 3 in. (5 x 7.6 cm)

3.5 x 5 in. (9 x 12.7 cm)

4 x 6 in. (10 x 15 cm)

4 x 7 in. (10 x 18 cm)

4 x 12 in. (10 x 30 cm) (Panoramic)

5 x 7 in. (13 x 18 cm)

8 x 10 in. (20 x 25 cm)

US Letter - 8.5 x 11 in. (22 x 28 cm) 

A4 (21 x 30 cm)

Quality Automatic

Brightness – 3 to + 3

Scanner type Contact Image Sensor (CIS)

Maximum scan size 8.5 x 11.7 in. (21.6 x 29.7 cm)

Functions Segmentation scanning

Auto-destination

Optical Character Recognition (OCR)
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Bottom input paper tray 

Top input paper tray 

Output paper tray 

Ink cartridges

Connectivity

Paper capacity 100 sheets of 20 lb plain paper

20 envelopes

Tray size 4 x 6 in. to 8.5 x 14 in. (10 x 15 cm to 21.6 x 36 cm)

Paper capacity 40 sheets of photo paper, up to 12 mil (290 gsm)

Tray size 4 x 6 in. to 5 x 7 in. (10 x 15 cm to 13 x 18 cm)

Paper capacity 50 sheets of 20 lb plain paper

Ink handling 2-cartridge, 6-ink system

Ink life 1-year warranty from date of purchase

Protocols supported USB 2.0 high speed

Devices supported Computers with WINDOWS OS and computers with MAC OS; 
mobile phones with custom print applications; memory cards 
(MMC, XD, SD, SDHC, COMPACTFLASH Types I and II, 
MICRODRIVE); PICTBRIDGE Technology enabled cameras, 
flash drives

Image formats supported Image printing supports JPEG (EXIF v2.21 non-progressive); 
does not support progressive JPEG format

Number of USB ports Two USB 2.0 high-speed ports, one device port on the back of 
the printer, one host port in the front

Wi-Fi technology
supported

802.11n, WPA, WMM, and WPS
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Software support

Physical specifications

Warranty

Application support Third-party image-management software; optical character 
reader (OCR) support for documents

Media support Plain paper, photo paper, envelopes, greeting cards, card stock, 
transparencies with white stripe, labels

Scanner support TWAIN and WIA, WIA2 (VISTA OS), including segmentation 
scanning

Update support Software and firmware updates available through Web support

Power WW: 110-240 V AC, 50-60 Hz 

Output: 36 V DC at 1.6 A

Dimensions 45 x 19 x 43 cm [L x W x D] 
(17.5. x 7.4. x 16.8 in.)

Weight 6.6 kg (14.5 lb) without power supply, printhead, or ink 
cartridges

Operating range 5° - 35°C (41°- 95°F), 15 to 85% RH (non-condensing) and 
atmospheric pressure of no less than 15 PSI (approximately 
10,000 ft.)

Full image quality
environmental range

15° - 30°C (59° - 86°F), and 20 to 80% RH. 

Energy efficiency ENERGY STAR® Qualified

Product One year from purchase (with proof of purchase)

Printhead One year from purchase (with proof of purchase)
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System requirements

Computer with WINDOWS OS

Computer with MAC OS

Computer Minimum

Operating System WINDOWS VISTA or XP Home (SP2 or later)

CPU Intel Celeron

Clock speed 1.2 GHz

Memory 512 MB RAM

Available hard disk space 500 MB available

Interface USB 

Removable drive CD-ROM

Computer Minimum

Operating System MACINTOSH OS X 10.4.8 or later

CPU PowerPC G4, G5, or Intel Based Mac

Clock speed 1.2 GHz

Memory 512 MB RAM

Available hard disk space 200 MB available

Interface USB

Removable drive CD-ROM
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Paper types supported

Paper sizes supported

Plain paper 20 to 24 lb (75 to 90 gsm)

Photo paper Up to 12 mil 

Card stock 110 lb index max (200 gsm)

Envelopes 20 to 24 lb (75 to 90 gsm)

Transparencies All commercially available inkjet varieties (with a white stripe)

Labels All commercially available inkjet varieties on 8.5 x 11 in. and A4 
size sheets

Iron-on transfers All commercially available inkjet varieties on 8.5 x 11 in. and A4 
size sheets

Plain paper A4 (8.3 x 11.7 in. / 21 x 30 cm)

A5 (5.8 x 8.3 in. / 15 x 21 cm)

A6 (4.1 x 5.8 in. / 11 x 15 cm)

B5 (6.9 x 9.8 in. / 18 x 25 cm)

US Executive (7.3 x 10.5 in. / 18 x 27 cm)

US Letter (8.5 x 11 in. / 22 x 28 cm)

US Legal (8.5 x 14 in. / 22 x 36 cm)

Custom sizes from 4–8.5 in. / 10–22 cm wide and 6–14 in. / 
15–36 cm long

Labels A4 (8.3 x 11.7 in. / 21 x 30 cm)

US Letter (8.5 x 11 in. / 22 x 28 cm)

Index card stock 4 x 6 in. index cards (10 x 15 cm)

5 x 7 in. index cards (13 x 18 cm)

Transparencies and
iron-on transfers

A4 (8.3 x 11.7 in. / 21 x 30 cm)

US Letter (8.5 x 11 in.) (216 x 280 mm)
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Envelopes C5 (6.4 x 9 in. / 16 x 23 cm)

C6 (4.5 x 6.4 in. / 11 x 16 cm)

DL (designated long) (4.3 x 8.7 in. / 11 x 22 cm)

US #10 (4.1 x 9.5 in / 11 x 24 cm)

US #7¾ (3.9 x 7.5 in. / 10 x 19 cm)

US #9 (3.9 x 8.9 in. / 10 x 23 cm)

Photos 4 x 6 in. (10 x 15 cm)

4 x 7 in. (10 x 18 cm)

4 x 12 in. (10 x 31 cm)

5 x 7 in. (13 x 18 cm)

8 x 10 in. (20 x 25 cm)

US Letter (8.5 x 11 in. / 22 x 28 cm)

A4 (8.3 x 11.7 in. / 21 x 30 cm)
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KODAK ESP 7200 Series All-in-One Printer
Safety information
• Always follow all warnings and instructions marked on the product.

• Use only the power source indicated on the product regulatory label.

• Use only the power cord that comes with the product. Using another power cord 
may cause fire and/or shock. Do not use the included power cord with any other 
equipment. 

• Always turn this product off by using the On/Off button. Wait until the On/Off 
button stops flashing before removing the power plug from the outlet. 

• Do not allow the power cord to become damaged or frayed.

• If you need to use an extension cord with this product, make sure that the 
ampere rating of the product does not exceed the ampere rating of the extension 
cord.

• Place the product on a flat, stable surface that extends beyond the product’s 
base in all directions. This product will not operate properly if tilted or at an 
angle.

• When storing or transporting this product, do not tilt or stand it on its side. 
Never turn this product upside down (ink can leak out of the product).

• Avoid placing this product in an environment that is subject to rapid changes in 
temperature or humidity, mechanical shocks, vibration, or dust. Do not place 
near radiators, heating vents, or in direct sunlight.

• Leave enough room around this product for sufficient ventilation. 

• Do not block this product’s covers or openings, or insert any objects through 
slots. 

• Do not use aerosol products inside or around this product.

• Do not spill any liquid on this product.

• Do not attempt to repair or service this product.

• If the power cord or plug is damaged, if any liquid has been spilled onto the 
product, if the product has been dropped or the case damaged, if the product 
does not operate normally or exhibits a major change in performance level, 
unplug this product and contact Kodak at www.kodak.com/go/contact.

LCD screen safety

• Use only a dry, soft cloth to clean the LCD screen. Do not use any liquid or 
chemical cleaners.

• If the LCD screen is damaged, contact Kodak immediately. If any of the solution 
from the display gets on your hands, wash them thoroughly with soap and water. 
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Product and Safety Specifications
Ink cartridge safety

• Keep all ink cartridges out of the reach of children.

• If ink gets on your skin, wash with soap and water. If ink gets into your eyes, flush 
immediately with water. If any discomfort or change in vision persists after 
washing, seek medical attention immediately.

• For MSDS information on inks, go to www.kodak.com/go/MSDS.

Regulatory compliance

FCC statement

The United States Federal Communications Commission (in CFR 47 Part 15.105) has 
specified that the following notice be brought to the attention of the users of this 
product:

NOTE: This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off 
and on, the user is encouraged to try to correct the interference by one or 
more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver

• Connect the product into an outlet on a circuit different from that to which 
the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

CAUTION:
Pursuant to Part 15.21 of the FCC Rules, any changes or modifications to this 
product not expressly approved by Eastman Kodak Company might cause 
harmful interference and void the FCC authorization to operate this product.

The radiated energy from this product is well below the FCC radio frequency 
exposure limits. Nevertheless, the product shall be used in such a manner 
that the potential for human contact during normal operation is minimized. 
This product and any attached external antenna, if supported, shall be placed 
in such a manner to minimize the potential for human contact during normal 
operation. In order to avoid the possibility of exceeding the FCC exposure 
limits, human proximity shall not be less than 20 cm (8 inches) during normal 
operation.
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KODAK ESP 7200 Series All-in-One Printer
Canadian statements

This product meets the applicable Industry Canada technical specifications.

Operation is subject to the following two conditions: (1) this device may not cause 
interference, and (2) this device must accept any interference, including interference 
that may cause undesired operation of the device.

This Class B digital apparatus complies with Canadian ICES-003.

Industry Canada (IC) Radiation Exposure Statement

This equipment complies with IC radiation exposure limits set forth for an 
uncontrolled environment. This equipment should be installed and operated with a 
minimum distance of 20 cm between the radiator and your person.

European compliance statement

Hereby, Eastman Kodak Company declares that this KODAK all-in-one wireless 
printer is in compliance with the essential requirements and other relevant 
provisions of Directive 1999/5/EC.

German compliance statement 

Noise emissions for this equipment do not exceed 70 dB(A).

This equipment is not intended for use in the work place in accordance with 
BildscharbV regulations.

“Das Gerät ist nicht für die Benutzung am Bildschirmarbeitsplatz gemäß 
BildscharbV vorgesehen.” 

REACH Article 33 declarations

Go to www.kodak.com/go/REACH for information about the presence of 
substances included on the candidate list according to article 59(1) of Regulation 
(EC) No. 1907/2006 (REACH).

Power supply information

Certified External Power Supply that can be used with this product: Hipro 
HP-A0601R3, or Flextronics VP-09500084-000.
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Waste electrical and electronic equipment labeling

In the European Union, do not discard this product as unsorted municipal waste. 
Contact your local authorities or go to www.kodak.com/go/recycle for recycling 
program information.

ENERGY STAR® Qualified

ENERGY STAR and the ENERGY STAR mark are registered U.S. service marks. As an 
ENERGY STAR partner, KODAK has determined that this product meets ENERGY 
STAR Guidelines for energy efficiency. For more information on the ENERGY STAR 
program, see www.energystar.gov. 

Warranty Information
Limited Warranty

Kodak warrants Kodak consumer electronic products and accessories (“Products”), 
excluding batteries, to be free from malfunctions and defects in both materials and 
workmanship for one year from the date of purchase. Retain the original dated sales 
receipt. Proof of the date of purchase will be required with any request for warranty 
repair.

Limited Warranty Coverage

Warranty service is only available from within the country where the Products were 
originally purchased. You may be required to send Products, at your expense, to the 
authorized service facility for the country where the Products were purchased. 
Kodak will repair or replace Products if they fail to function properly during the 
warranty period, subject to any conditions and/or limitations stated herein. 
Warranty service will include all labor as well as any necessary adjustments and/or 
replacement parts. If Kodak is unable to repair or replace a Product, Kodak will, at its 
option, refund the purchase price paid for the Product provided the Product has been 
returned to Kodak together with proof of the purchase price paid. Repair, 
replacement, or refund of the purchase price are the sole remedies under this 
warranty. If replacement parts are used in making repairs, those parts may be 
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KODAK ESP 7200 Series All-in-One Printer
remanufactured or may contain remanufactured materials. If it is necessary to 
replace the entire Product, it may be replaced with a remanufactured Product. 
Remanufactured Products, parts and materials are warranted for the remaining 
warranty term of the original Product, or 90 days after the date of repair or 
replacement, whichever is longer.

Limitations

This warranty does not cover circumstances beyond Kodak’s control. This warranty 
does not apply when failure is due to shipping damage, accident, alteration, 
modification, unauthorized service, misuse, abuse, use with incompatible 
accessories or attachments (such as third party ink or ink tanks), failure to follow 
Kodak’s operation, maintenance or repacking instructions, failure to use items 
supplied by Kodak (such as adapters and cables), or claims made after the duration 
of this warranty. KODAK MAKES NO OTHER EXPRESS OR IMPLIED WARRANTY 
FOR THIS PRODUCT, AND DISCLAIMS THE IMPLIED WARRANTIES AND 
CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. In the event that the exclusion of any implied warranty is ineffective 
under the law, the duration of the implied warranty will be one year from the 
purchase date or such longer period as required by law. The option of repair, 
replacement, or refund is Kodak’s only obligation. Kodak will not be responsible for 
any special, consequential or incidental damages resulting from the sale, purchase, 
or use of this product regardless of the cause. Liability for any special consequential 
or incidental damages (including but not limited to loss of revenue or profit, 
downtime costs, loss of the use of the equipment, cost of substitute equipment, 
facilities or services or claims of your customers for such damages resulting from 
the purchase, use or failure of the Product), regardless of cause, or for breach of any 
written or implied warranty is expressly disclaimed.

Your Rights

Some states or jurisdictions do not allow exclusion or limitation of incidental or 
consequential damages, so the above limitation or exclusion may not apply to you. 
Some states or jurisdictions do not allow limitations on how long an implied 
warranty lasts, so the above limitation may not apply to you. This warranty gives you 
specific rights, and you may have other rights which vary from state to state or by 
jurisdiction. Your statutory rights are not affected.

Outside the United States and Canada

In countries other than the United States and Canada, the terms and conditions of 
this warranty may be different. Unless a specific Kodak warranty is communicated to 
the purchaser in writing by a Kodak company, no warranty or liability exists beyond 
any minimum requirements imposed by law, even though defect, damage, or loss 
may be by negligence or other act.
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Declaration of Conformity

Declares our sole responsibility that the product

conforms to the following Product Specifications:

The product was tested in a typical configuration.

Manufacturer's Name: Eastman Kodak Company

Manufacturer's Address: 16275 Technology Drive

San Diego, CA 92127, USA

Product Name: KODAK ESP 7250 Series All-in-One Printer 

Power adapters: HP-A0601R3, VP-09500084-000

Radio Module Number: WLU6120

Safety: IEC 60950-1:2001
EN 60950-1:2001 + A11:2004
UL 60950-1:2003 R7.06
CAN/CSA-C22.2 No. 60950-1-03

Radio: EN 301 489-1 V1.8.1 (2008-04)
EN 301 489-17 V1.3.2 (2008-04)
AS/NZS 4268:2003 + A1:2005 + A2:2006

EMC: EN 55022:2006+A1:2007, Class B
CISPR 22:1997 Class B
EN 61000-3-2:2006, Class A
EN 61000-3-3:1995+A1:2001 +A2:2005
AS/NZS CISPR 22:2006, Class B
EN 61000-4-2:1995 + A1:1998 + A2:2001
EN 61000-4-3:2006 + A1:2008
EN 61000-4-4:2004
EN 61000-4-11:2004
EN 61000-4-8:2001 ED 1.1
CFR 47, FCC Part 15, Subpart B, Class B
EN 61000-4-5:2006
EN 61000-4-6:2007
ICES–003:2004 Class B
ANSI C63.4-2003
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B
back button, 2
black-and-white copies, 40, 45
BLUETOOTH Technology enabled device

printing pictures from, 37
bottom tray, 45
button sounds, changing, 4
buttons, on control panel, 2

C
cancel button, 2
card slot

CF, 1
MS/XD/SD, 1

CF card slot, 1
cleaning

document backing, 56
printer, 55
scanner glass, 56

cleanout area, 1
color copies, 40, 45
computer requirements, 76
configuring printer settings, 4
connecting to Ethernet network, 11

from USB, 13—14
connecting to wireless network, 5—10

additional printer, 10
from USB, 12—13
printer on additional computers, 10

connection to printer, changing
USB to Ethernet, 14
USB to wireless, 12—13

control panel, 1, 2
copying, 39—49

documents, 39—43
adjusting settings, 40—41
black-and-white, 40
brightness, 41, 43
color, 40
copy sizes, 73
darkening, 41, 43
enlarging, 40, 42
features, 73
fit to page, 40
lightening, 41, 43
number of copies, 40, 41
quality, 41
quantity, 40, 41
reducing, 40, 42

photos, 44—49
adjusting settings, 45—46
black-and-white, 45
brightness, 46, 49
color, 45
copy sizes, 73
darkening, 46, 49
enlarging, 46, 48
features, 73
lightening, 46, 49
number of copies, 45, 47
previewing on LCD, 46
quality, 46
quantity, 45, 47
reducing, 46, 48
sizes, 46
using default settings, 44

country/region, setting, 4
cropping pictures, 36

D
darkening copies

documents, 41, 43
photos, 46, 49

date and time
setting, 4
synchronizing to computer, 4

declaration of conformity, 84
defaults

resetting, 4, 67
save copy settings as

documents, 41
photos, 46

save scan settings as, 54
digital print order format, 4
document backing, cleaning, 56
documents

copying, 39—43
paper sizes, 77
printing, 27—29
printing from wireless device, 37

double-sided printing, 27
DPOF, 34
DPOF printing, 4
duplex printing, 27
duplexer, location, 1
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Index
E
EASYSHARE Software, 30
ENERGY STAR qualification, 82
enlarging copies

documents, 40, 42
photos, 46, 48

envelopes
loading, 24
sizes, 16, 78

Ethernet network
changing from USB, 13—14
connecting printer to, 11
MAC OS computer, connecting, 14
requirements for connecting, 11
WINDOWS OS computer, connecting, 14

Ethernet port, 1
extender, output paper tray, 1

F
firewall, disabling, 5
firmware, updating, 65
front paper-edge guides, 1

G
glass, scanner, 1

cleaning, 56
graph paper, printing, 29
grocery list, printing, 29

H
home button, 2
Home Center Software, 3
hostname, printer, 9

I
Image Capture software, 38
image formats supported, 74
index card stock, sizes, 77
ink cartridges

location, 1
replacing, 58—60

ink levels, 58, 66
IP address, 8
IP address, viewing, 9
iPhoto software, 38
iron-on transfers, sizes, 77

K
keyboard on LCD

using, 5, 7
KODAK EASYSHARE Software, 30
KODAK Home Center Software. See Home Center 

Software
KODAK Pic Flick App, 37

L
label sizes, 77
language, setting, 4
LCD, 2
left paper-edge guide, 1
legal-size paper

capacity, 19
loading, 19

light
power status, 71
Wi-Fi status, 71

lightening copies
documents, 41, 43
photos, 46, 49

loading paper
envelopes, 24
legal-size paper, 19
photo paper, 22
plain paper, 17

M
MAC address, viewing, 9
MAC OS computer

connecting printer
Ethernet, 14
wireless, 13

main paper tray, 1, 45
capacity

legal-size paper, 19
plain paper, 17

media supported, 77
memory cards, 30
MS/XD/SD card slot, 1

N
narrow-ruled paper, printing, 29
navigation buttons, 2
network configuration

printing, 10
viewing, 9
86 www.kodak.com/go/aiosupport



Index
network name (SSID), 5
network subnet, viewing, 9
network, Ethernet

connecting printer to, 11
requirements for connecting, 11

network, wireless
connecting

non-WPS router, 6
WPS router, 7

connecting to, 5—10
installing printer on, 10
IP address, 8

O
OK button, 2
on/off button, 2
output paper tray, 1
output tray

capacity, 74
output tray extender, 1

P
panel, control, 1, 2
panoramic pictures, printing, 35
paper, 15—25

loading
envelopes, 24
legal-size paper, 19
photo paper, 22
plain paper, 17

sizes, 15, 77
types, 15, 77

paper jam
cleanout area, 1

paper stop, 1, 18
paper tray

bottom, 45
capacity, 74

extender for legal paper, 1
main, 1, 45

capacity, 74
output, 1
photo, 1, 45

capacity, 74
selecting, 45
top, 45

capacity, 74

paper tray, main
capacity

envelopes, 24
legal-size paper, 19
plain paper, 17

loading
envelopes, 24
legal-size paper, 19
plain paper, 17

paper tray, output
capacity, 74

paper tray, photo
capacity, 22
loading, 22

paper trays
switching, 26

paper-edge guide
front, 1
left, 1

photo paper
capacity, 22
loading, 22

photo paper sizes, 78
photo paper tray, 1, 45
photo printing

image enhancement, 72
print sizes, 72
quality, 72
scene balance, 72

Pic Flick App, 37
pictures

cropping, 36
printing, 30—37

DPOF, 34
from BLUETOOTH Technology enabled 

device, 37
from wireless device, 37
panoramic, 35
tagged, 34

transferring to computer, 38
zooming, 36

plain paper
capacity, 17
loading, 17

port
Ethernet, 1
power cord, 1
USB, 1
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Index
power button, 2
power cord port, 1
power status light, 71
printer

cleaning instructions, 55
components, 1
defaults, resetting, 4, 67
hostname, 9
maintaining, 55—67
settings, configuring, 4
supplies

recycling, 55
printer access door, 1
printer connection, changing

USB to Ethernet, 14
USB to wireless, 12

printhead
location, 1
removing, 62
replacing, 61—65

printing, 26—38
documents, 27—29
forms, 29
graph paper, 29
grocery list, 29
narrow-ruled paper, 29
pictures, 30—37

DPOF, 34
from BLUETOOTH Technology enabled 

device, 37
from memory card, 30
from USB-connected device, 30
panoramic, 35
tagged, 34

reminder list, 29
sheet music, 29
speed, 72
tagged pictures, 4
tic-tac-toe, 29
two-sided documents

automatically, 27
manually, 28

wide-ruled paper, 29

R
rear-access cleanout area, 1
recycling printer or supplies, 55
reducing copies

documents, 40, 42
photos, 46, 48

regulatory compliance, 80
Canadian, 81
European, 81
German, 81
REACH Article 33 declarations, 81
waste labeling, European Union, 82

reminder list, printing, 29
removing printhead, 62
replacing ink cartridges, 58—60
resolution, scanning, 50, 51

S
safety information, 79—80
scanner glass

cleaning, 56
location, 1

scanner lid, 1
scanner type, 73
scanning, 50—54

features, 73
file format

document, 50
picture, 51

from computer, 51—52
from control panel, 53
maximum scan size, 73
multiple pictures simultaneously, 52
quality, 51
resolution, 50, 51
setting options, 53—54

settings
copy documents, 40—41
copy photos, 45—46
scanning, 53—54

sheet music, printing, 29
software

support, 75
updating, 65

sounds, changing, 4
specifications, 72—78

physical dimensions, 75
power, 75
weight, 75

SSID, 5
start button, 2
system requirements, 76

T
tic-tac-toe, printing, 29
time to low power, setting, 4
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Index
top tray, 45
transferring pictures to computer, 38
transparency sizes, 77
tray

selecting, 45
trays

switching, 26
troubleshooting, 68—71

error messages, 69
help on the web, 70
ink cartridge, 69
paper jam, 69
power, 68
print quality, 69
printer not detected, 68
printhead carriage jam, 68
wireless connectivity, 68

two-sided printing, 27

U
updating

printer firmware, 65
software, 65

USB connection, changing
to Ethernet, 13—14
to wireless, 12—13

USB port
back, 1
front, 1

W
warranty, 75, 82—83

ink, 74
Web support

contact information, 69, 70, 79
downloads, 70
Electronics Industry Alliance, 55
ENERGY STAR program, 82
firmware update, 66
interactive troubleshooting, 69, 70
iPhone software, 37
iPod Touch Device software, 37
Material Safety Data Sheets (MSDS), 80
networking, 7, 8, 12, 68, 70
Pic Flick App, 37
printer support, 70
REACH Article 33 declarations, 81
recycling, 55
system requirements, 70

WEP key, 5, 7
wide-ruled paper, printing, 29

Wi-Fi
connectivity LED, 2
status light, 71
technology supported, 74

WiFi Setup wizard, 6
window for photo paper, 1
WINDOWS OS computer

connecting printer
Ethernet, 14
wireless, 12

wireless device, printing from, 37
wireless network

configuration
printing, 10
viewing, 9

connecting
additional printer, 10
non-WPS router, 6
printer on additional computers, 10
WPS router, 7

connecting to, 5—10
from USB, 12
using WiFi Setup wizard, 6

IP address, 8
settings, configuring, 5

WPA/WPA2 passphrase, 5, 7
WPS router, 7

Z
zoom button, 2
zooming pictures, 36
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